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Welcome to ConceptDraw DIAGRAM v13 for Windows

Computer Systems Odessa Corporation introduces you ConceptDraw DIAGRAM - a world-class
diagramming software that lets you display, communicate, and present dynamically on Mac and PC
platforms.. ConceptDraw DIAGRAM is powerful enough to draw everything from basic flowcharts to
complex engineering schematics.
World-Class Diagramming
Benefits
ConceptDraw Maintenance Assurance
Technical Support

 
World-Class Diagramming
ConceptDraw DIAGRAM is a diagramming tool that lets you easily create diagrams in minutes to
support any business communication process. You can create simple or complex drawings to
communicate status or condition to your audience.
ConceptDraw DIAGRAM creates drawings, diagrams and charts with great visual appeal. It is simple to
express ideas to share with others that quickly convey what you are thinking when using ConceptDraw
DIAGRAM. It is a spectacular, easy-to-use tool for preparing presentations and business documentation,
describing structures and processes, making schematic diagrams, and drawing technical sketches.
 ConceptDraw DIAGRAM is powerful enough to be the standard-bearer business graphic tool for
organizations of any size, producing rich visual documents that convey meaning and support company’s
internal and external communication needs. Graphic company communications include dashboards
displaying key performance indicators and depiction of processes based on company data. From simple
to complex, ConceptDraw DIAGRAM fills every niche.

 
Your Benefits
Simplifies and enhances presentation generation with flexible slide construction, automated processes,
and Live Object technology for displaying external data. Contains an extensive library of over 20,000
ready-to-use objects, with hundreds of templates and examples to get you started quickly.
ConceptDraw DIAGRAM also supports dynamic presentations that contain live content and can be
edited on the fly to reflect input from collaboration or feedback. Presentations can be exported to
numerous graphical formats or emailed as a slide show. ConceptDraw DIAGRAM presentations can be
displayed in full-screen, automated playback mode, or using dual monitors — display on one, edit on the
other — for team collaboration.

 
ConceptDraw Maintenance Assurance 
We have developed an innovative maintenance program that makes sure you stay up to date. At the time
of your buy a ConceptDraw product, you are able to purchase ConceptDraw Maintenance Assurance 

 
Technical Support
We offer unlimited free technical support to our users.
To send us a problem report or feature request, submit the ticket form in the Help Desk section on our
Web site.
Replies are normally sent within one business day. We are always happy to answer your questions and
hear your feedback.

https://www.conceptdraw.com/helpdesk/how-to-upgrade-at-no-charge
https://helpdesk.conceptdraw.com/ticket.php


Toolbar Tour

ConceptDraw DIAGRAM  User Interface Reference © 2020 CS Odessa corp.

2

  

Toolbar Tour

The ConceptDraw DIAGRAM   toolbar  provides quick access to functions that are commonly performed
within the program.

Quick Access
File
Home
Shape
Document
View
Share
Developer
Help
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Quick Access  

Quick Access

Quick Access menu facilitates access to the most  frequently used functions. It is located at the top of

Toolbar.

 

New Document - Create new blank document

Open - Open existing document

Undo - Undo the last action

Redo - Redo the last undone action

Save - Save  the current document

Print Preview - Preview and make changes to pages before printing

Customize Quick Access Toolbar - Customize Quick Access Toolbar
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Help Menu  

Help Menu

ConceptDraw DIAGRAM Help: Calls the ConceptDraw DIAGRAM Help System. It opens in a separate
window where you can see a number of articles containing information on how to use the product. You
can read or print the articles, search them for the needed information.
Keyboard Shortcuts: Calls the ConceptDraw DIAGRAM ready-to-print list of the  keyboard shortcuts in
 pdf format

Getting Started: Opens the Getting Started guide in the PDF format

Online Help Desk: Allows you to ask a question to ConceptDraw DIAGRAM Support Team

Check for Update: Runs ConceptDraw STORE and opens the Available Updates tab

About ConceptDraw: Opens the About window, where you can see the information about the
application version and developers.
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File  

File

 
New

Default Blank Drawing: When you create a new blank document, DIAGRAM applies the default
page dimensions, orientation and other settings that are stored in a default template.
If you frequently use settings that differs from the default template, you can set new defaults that
DIAGRAM uses when you create a new document. 

US Letter Drawing (Portrait): Create a new US Letter  size document with a portrait  page
orientation

US Letter Drawing (Landscape): Create a new US Letter  size document with a landscape 
page orientation

A4 Drawing (Portrait): Create a new A4  size document with a portrait  page orientation

A4 Drawing (Landscape): Create a new A4  size document with a landscape  page orientation

Temp
late
Setup

Call the Template Setup dialog

Open Call the Open dialog

Rece
nt

See the list of the recently opened files

Save Call the Save dialog

Save
as

Call the Save as dialog

Import  

Graphic File: Import data from graphic formats (emf, wmf, pct, pict, bmp, dib, gif, jpeg, jpg, png,
tif, tiff)

Microsoft PowerPoint: Import  data from Microsoft Office PowerPoint Document (.pptx, ppt)

Microsoft Visio Drawings: Import  data from Microsoft Visio Drawing (vsd, .vsdx, vdx)

Microsoft Visio Stencils : Import  data from Microsoft Visio Stencil (.vssx, vss)

PDF as Image : Import Adobe Acrobat document as image 

SVG: Import Scalable Vector Graphics format
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File  

Export  

Adobe Flash (SWF): Save document as Adobe Flash (SWF) file, using Flash Export Settings
dialog

PDF: Save document as Adobe Acrobat (PDF) file

EPS: Save document as Encapsulated PostScript (EPS) vector file

Graphic File: Save document as graphic file (emf, bmp, dib, gif, jpeg, jpg, png, svg,  tif, tiff)

HTML: Save document as HTML file

Microsoft PowerPoint : Save document as Microsoft Office PowerPoint Document (.pptx, .ppt)

Microsoft Visio 2010 (VDX): Save document as Microsoft Visio 2003-2010 Drawing (.vdx) file

Microsoft Visio 2013 (VSDX): Save document as  Microsoft Visio Drawing (.vsdx) file

SVG: Save document as  SVG file

  

Library  

New: Create new library

Open:  Open an existing library

Save:  Save active library

Close All Save as:  Save a copy of active library

Send via email: Send an active library via e-mail

Close:  Close the  active library of the current document

Close all:  Close all libraries used in the current document

Properties: Show Library Properties dialog box
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File  

Print Print the current document

Send via
Email

Save the currently opened document and attach it to email message using the
default email client.

Close Close the currently opened document

Properties Call the Properties dialog

Options Call the Options dialog



Toolbar Tour

ConceptDraw DIAGRAM  User Interface Reference © 2020 CS Odessa corp.

8

File Properties

Properties

This dialog is used to set the parameters of the current document.
To call it choose Properties... from the File menu.
The dialog contains several tabs, which control various groups of settings:
Print Setup - contains information that describes the document
Page Size - sets the size and orientation of the document pages
Info - contains information that describes the document
Units, Scale, Options - sets the scale, units of measure, etc.
Advanced - contains settings that control access, export to HTML, the behavior of connectors. 

Print Setup tab

Printer paper - lets you select printer paper size from the list.
Portrait/Landscape - defines the document page orientation.
Setup... - opens the system printer settings dialog.
Print Zoom - lets you adjust the document pages to the printer pages.
Justification - defines the justification of the document page on the printer page.
Print background pages separately - lets you print the background pages of the document as separate
pages.
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File Properties

Page Size tab

 
The left part of the tab contains the settings. The right part has the preview area, where you can see the
results of the changes you apply. The document page is represented by the white rectangle, the printer
page is represented by the shaded rectangle. The size and orientation of the printer page are taken from
the current print settings.
Document Size setting allows to choose the size of the document page. The following options are
available:

Same as printer paper size - the document page has the same size as the printer page.
Pre-defined size - allows to choose one of the pre-defined sizes from the drop-down list.

Custom size - lets you set a custom page size:
Width - specifies the page width
Height - specifies the page height

Orientation - switch between portrait and landscape layouts
Adjust to drawing contents - the page size is set enough to fit all shapes in the drawing. If the document

contains several pages, the biggest value is used.
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File Properties

Info tab

Title - contains the title of the document
Keywords - in this field you can enter the keywords which the search engines will use to  include the
given document in their search results.
Author - contains the name of the author
Company - contains the name of the company
Description - a detailed description of the document
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File Properties

Units, Scale Options tab

Units of measure - allows to choose the unit of measure from the drop-down list.
Display angles in - sets whether to display the angles in degrees or radians.
The Scale setting determines the scale of the document. The following options are available:
No scale (1:1) - the 1:1 scale.
Pre-defined scale - allows to choose a scale from the list. The scale is set with the help of two drop-
down lists. The first one allows to choose the type of the drawing:

Metric
Civil Engineering
Mechanical Engineering
Architectural

Depending on the chosen option you can choose a pre-defined scale in the second drop-down list. If the
Civil Engineering or Architectural options are chosen, non-metric (imperial) units of measure are set
automatically in the Units of measure field. You can change the units of measure manually if needed.
Custom scale - sets a user-defined scale. You can use different units of measure by specifying the
appropriate suffix after the value (for example, 1 ft = 1 in).
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File Properties

Advanced tab

 

The Connectors and Routing section contains settings that describe the behavior of smart connectors.
Max. numbers of legs - sets the maximum number of connector's legs. By default the number of legs is
not limited.
Min. distance to shape - sets the minimum distance the smart connector keeps from the shapes on its
way.
Line jump size - indicates the size of connector crossings.
Note: This setting only determines the size, not the type and style of the crossing (see the Connectors
Routing section ).

When crossing groups -  sets how the connector behaves when it crosses a group:
Pass through - passes through the group, flowing around the shapes inside.
Flow around - flows around the entire group as if it were a single shape.

The Protect Access to Document area lets you limit access to the document. The program will ask for a
user name and password on an attempt to open the document. Only authorized users will be able to view
and edit the document.
Add User - adds a new user to the list using the Edit User dialog,
Edit User - allows to change the user name and password,
Remove User - deletes user from the list.
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File Options

Options

This dialog controls the application settings. To call the dialog, choose Options from the File menu. The
dialog contains several tabs, where various settings are grouped:

General - contains the default settings for new documents,
View - determines the appearance of some components of the application,
Save - contains the saving parameters of the documents,
Advanced - describes scripting and ConceptDraw Basic Editor settings.
Spelling - contains the saving parameters of the documents.

 General tab

This tab describes the parameters of the documents, created with the New command. You can choose
whether to base a new document on the default settings or on a default template file:
New Document with Default Settings - Document is created with the default Template Setup parameters.
New Document with Custom Template  - Choose a template file, on which every new document will be
based. Use the Browse button to choose the file, or specify the path in the edit field.
Undo/Redo and Snap - Set the maximum number of Undo/Redo operations and set the maximum

distance between objects to activate the Snap&Glue behavior

Edit Text Mode Options - Choose options most suitable when working with text. 

Other Options - Set of additional options:

Use mouse scroll to change zoom - enable using mouse to change zoome.

Keep original format for inserted images - enable to insert images keeping their original format.

Embed objects into a connector path - enablle to  insert an object directly in the connector path.
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File Options

View tab

Display Options section determines how text and hyperlinks are displayed in the program:

Enable auto-scrolling - if enabled, the document will be scrolled when you position the mouse
pointer over an edge of the window.
Enable floating window dock ing - Lets you dock floating windows as tabs when dragging one
 window to another. 
WYSIWYG font list - If enabled, all font names will be live previewed in the font list.
Mark hyperlinks to text - turns on the hyperlink auto parsing mode.
Small tool switching - allows small tool switching.
Automatically zoom under ... points when editing text - lets you adjust the text editing
functionality. You can enable the auto zoom in the document if the text looks too small, and
set the minimum font size acceptable for text editing mode (setting the font size best
viewed).

.
Show section contains settings for screen tips:

Library window screen tips - specifies whether to display screen tips when the mouse pointer
is paused over a library shape.
Shape screen tips - specifies whether to display screen tip for shapes in a document (see the
description of the Info floating dialog and the Information tab of the Shape Properties dialog).
Control handle screen tips - specifies whether to display screen tip for control handles.
Show developer tab - show/hide the Developer tab enabling ConceptDraw Basic Script
editing.
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File Options

Save tab

Save Options section describes the auto-save parameters of the application.

Save AutoBackup every ... minutes - saves a backup copy of the document automatically after the
specified time interval. 

Note: if you're work ing with large multi-page documents, don't specify a very small interval as it may slow
down work ing.

The Format Options section contains the parameters that set the default format of the document.

By default save file as - sets the format in which new documents will be saved. 
Save workspace with document - if this parameter is enabled, the document stores the arrangement of
open windows, libraries, etc. This arrangement is restored when you open the document. 
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File Options

Advanced tab

The Scripting Settings section sets how ConceptDraw Basic scripts will be treated by ConceptDraw:
Allow to run ConceptDraw Basic automatically - allows the program to run scripts
automatically,
Allow editing ConceptDraw Basic scripts - allows to edit scripts.

The CD Basic Editor Window specifies how the CD Basic Editor window looks. You can choose the font
and font size, and preview them in the area below:

Font - select a font from the list,
Size - select a font size from the list. 
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File Options

Spell Check tab

Put a tick in front of the languages you use in your document for correct spell check. 
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File Template Setup

Template Setup

This tab contains settings of the default template. Starting with the New document and selecting the
Default document option, you get the workspace corresponding to these settings.

Printer and Page Setup
Here you can set the print settings for the document, and select the size and orientation of pages in the
current document as well as in all further new documents. 
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File Template Setup

Units, Scale, Snap and Other Setup

Here you can set measurement units and scale. The grid and snap options can be also set here. All
settings will may by applied to the current document  as well as to all further new documents.



Toolbar Tour

ConceptDraw DIAGRAM  User Interface Reference © 2020 CS Odessa corp.

20

File Print

Print

Print - send the ConceptDraw DIAGRAM  document directly to the default printer without making
changes.
Print Preview - view the document and make changes to pages before printing. 
 

 
Print: Preview and print  document

Select Printer: Change default printer

Print Setup: Show Printer Setup dialog box

Options: Show/hide grid lines and background  for printing

Range:  Select the range of pages that you want to print

Size: Select the paper size

Orientation: Switch between portrait and landscape layouts

Drawing Justification: Select margins for current document

Scale: Select the print scale

Previous Page: View  previous page of document

Next Page: View next page of document

Close Print Preview: Close Print Preview and return to edit 
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Home  

Home

Clipboard
Text Format
Solutions
Select
Tools
Flowchart
Panels
Editing

Clipboard
 The clipboard group includes  functions  that enable you to copy and paste data.

Paste  - Paste Clipboard contents.
Paste Special   -  Activate Paste Special dialog.
Paste Special as Previous  -  Paste special into the same place as previous.
Paste in a Place  -  Paste object over the copied object.

Cut (Ctrl+X)  -  Cut the selection and put it on the Clipboard.

Copy (Ctrl+C)  -  Copy selection and place in Clipboard.
Format Painter - Apply formatting of a particular object 
to other objects on the page.

Text Format 
You can change the format of text in a selected object using  these text formatting options

Select the drawing object that contains the text that you want to format. Click the formatting buttons that
you want to use, or Right-click the  selected object and use context menu to open Text Properties
dialog.

Solutions
Here you can access the content of  solutions. Use the button to  open  Solutions Panel
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Home  

Select

To make changes to an object, or to a text within it, you  need to select it first, and for some  changes,
you need to select multiple shapes.
Here you can find a set of selection tools designed to work with the selected objects.

Tools
You can create your own custom objects by using the rectangle, ellipse, line and other drawing tools
from Tools group.

Flowchart
Flowcharts are diagrams that show the steps in a process. Basic flowcharts are easy to create and,
because the shapes are simple and visual, they are easy to understand. 
ConceptDraw DIAGRAM comes with a set of Flowchart tools designed to simplify flowcharts creation. 

Panels
Access to  Arrange and Format floating panels.

Editing
You can perform text edits and substitutions of selected objects.

Open the Find/ Replace dialog box (Ctrl+Alt+F)

Check the text spelling.

You can change the selected object by another using the following options:  
 

 

Selected Objects with Primary:  Change the selected object  to  the primary  object.  

Selected with Library Object (Ctrl+Space): Change the object selected on a document page to the
selected library object. 
Library Object with Selected  (Ctrl+Shift+I): Change the selected library object to the object selected
on a document page.  
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Home Format Painter

Format Painter

You can apply formatting of a particular object to other objects on the page using the Format Painter tool

. There are a few ways to use this tool:

Apply the Embedded Style to Objects

1. Select one of the embedded styles in the Format panel. 

2. Click the Format Painter tool  . 
3. Click a single object in a document, or select a group of objects with selecting frame. 
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Home Format Painter

Apply Formatting of Particular Object to Other Objects

1. Select an object. 
2. Copy the selected object (Ctrl+C).

3. Click the Format Painter tool .
4. Click a single object in a document, or select a group of objects with selecting frame. 
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Home Select

Select

Selection Tool  is active by default.
To select a single shape, point the Selection tool to the object. When the pointer turns into a four-headed
arrow, click the object.  Green handles and the shape functional buttons appear on the shape when you
select it providing you with quick access to some operations that can be carried out with the selected
object. The yellow control handle is intended for the object's text shifting.  Some complex objects are
supplied with additional control handles used for changing the positions of parts of objects relative to
each other.

When you want to change a number of objects, you can select multiple objects to work with them all at
once. Point  Selection tool to the object. Place the pointer above and to the left of the objects you want
to select, and then drag to create a selection area around the objects. After you select the shapes, you'll
see green selection handles around the primary object. Other objects will have blue selection handles.

ConceptDraw DIAGRAM provides several tools for selecting objects. Knowing how to use each tool
makes working with objects easy.

Select Next Object  -  Select the next object following the order of
creation.
Select Previous Object -  Select the previous object  following the order
of creation.
Select All (Ctrl+A) - Select all objects  on the page.
Select Connected  objects.
Select  all objects that are connected to selected object.
Delete Selected Objects - Delete the selected objects.
Delete Selected Links - Delete Selected Connectors.
Activate Eyedropper tool. The Eyedropper tool is used to sample a color
from an image to use this color further.

 Text Selection Tool 
Activate the Text Selection tool when you need to edit a text in ConceptDraw document.

Click the mouse once to activate the edit mode

Double-click to select the whole word.
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Home Tools

Tools

You can customize your drawings by adding yourself-drawn objects, text, or comments using Tools.

Rectangle (Ctrl+7) - Click in the upper left corner of where you want to place your
rectangle and drag to the lower right corner to define the rectangle.
To draw a square, hold the Shift key down while dragging down and across the screen.

Text Box  (Ctrl+2)  - Insert, remove and resize text. Double-Click or press F2 to start
text edits

Callout - Click in the upper left corner of where you want to place your callout and drag
to the lower right corner to define its shape.
To draw a square, hold the Shift key down while dragging down and across the screen.
Use Action Menu to hide all callouts
To show all callouts, go to the Layers panel and switch on the "Comments" layer
visibility.

Line (Ctrl+3) - Draw straight line.

Spline (Ctrl+6) - Draw a  freeform line.

Ellipse (Ctrl+8) - Click in the upper left corner of where you want to place your ellipse
and drag to the lower right corner to define the ellipse.
To draw a circle, hold the Shift key down while dragging down and across the screen

Title Text Box - Add pre-formatted  titles and headings. 

Direct Connector - Draw Direct Connector between objects.

Click on the object you want to connect and drag to other object to connect it.

Arc (Ctrl+5)

Edit Vertex - Activate this tool to  see the vertices of the object.  You can change the
form of object  by dragging the vertex. Drag the vertex where you want it and then
release the mouse button.
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Home Flowchart

Flowchart

 
Flowchart 

Connector

ConceptDraw DIAGRAM makes it easy to connect objects in your drawing. You can use one of the the
Connector tools. To connect elements using this tool, drag the connector from one connect point to
another. Direct Connectors are straight lines from the point of origin to the point of contact. Smart , Arc,
Bezier and Curve Connectors are drawn very similarly to Direct Connectors. 

 Direct Connector    Arc Connector 

 Bezier Connector  Smart Connector

 Curve Connector

Activate Rapid Draw mode for selected object(s).

Activate the Chain Connection Mode.
Consistently connect  selected objects with  Connectors.

New object will  be automatically connected to selected one.  You can change
the connector's appearance using the Format panel.

Activate the Tree Connection Mode.
Connect  selected objects with  Connectors in a tree structure.

New object will  be automatically connected to selected one. You can change
the connector's appearance Using the Format panel.
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Home Flowchart

Activate Clone or Duplicate tool. 
Clone tool allows to create the unlimited number of copies of the selected
object(s). Click any place of the document to insert a copy of the selected
object(s). Press Escape to turn off the Clone tool.
Using Duplicate tool creates one exact duplicate of the selected object(s).

 Activate snapping specified in the Snap&Glue Settings dialog.

Connectors can automatically route around objects already placed in your drawing. Also, you can insert
a new object  directly in the connector path. If you want to do this, you need to check the corresponding
option in the General tab of the Options dialog
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Home Flowchart

Rapid Draw

Rapid Draw 
 

 
Rapid Draw mode allows you to build professional diagram quickly and easily. Add the first object to a
document. It will be a  start point for your chart.  Activate the Rapid Draw mode  and then hover your
mouse over an object at a drawing page. Click one of the small blue arrows that appear to draw a Smart
Connector and Duplicate of the selection in the chosen direction.  Rapid Draw mode allows you to create
a diagram with just the keyboard. Use the combination Ctrl+Arrow keys to add and connect the next
object in a proper direction. 
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Home Flowchart

Some ConceptDraw DIAGRAM libraries have built-in Rapid Draw features for their objects
For example, the Flowchart Rapid Draw library. 

Engage Rapid Draw object from a library and then hover your mouse over an object at a drawing page.
Directional arrows surround the selected object. Select the appropriate direction for your diagram. Then,
select the object you want to add. 
You can create your diagram with just the keyboard. Use the combination Ctrl+Arrow keys to select the
direction. 
Then, continue to press the same keys until the appropriate object is selected and press Enter.
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Shape  

Shape

Insert
Text
Point
Run Around Objects
Operations
Image Tool
Group
Properties

Insert
When working on a document in ConceptDraw DIAGRAM, you can perform some inserts..

  

Insert Picture 
Insert picture from file

Hypernote:
Activate the Hypernote Panel

Rapid
Draw

Activate the Rapid Draw functionality for  selected objects  

Order
Here are object order tools. They help you control the placement of overlapping objects.

Back: Move the selected object behind all other objects.
Backword: Move the selected object one step back.

Front: Move the element in front of all other elements.
Forward: Move the selected object one step forward.
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Shape  

Text
Several elements are involved in working with the text of an object.

Point
Point Connection Mode.

 Activate Connection Point tool. You can add any number of connection points to selected object as well
as to empty space in your document.

Run Around Objects

ConceptDraw DIAGRAM makes it easy to connect objects in your drawing. Connectors  will
automatically route around objects already placed in your drawing. Use this button before you start
drawing when you would like  to disable routing around  objects. You can manage 

 

Run Around
mode
enabled:

 Run Around mode disabled:
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Shape  

Operations
Sometimes the best way to draw a custom object  is to take several standard objects and combine or
change them to get the desired geometry. Using functionality from the Operations group , you can create
your custom unique objects out of the geometry of standard library objects. 

Image Tool

You can crop the inserted image to remove any unwanted areas
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Shape  

Group

You can group Group and Ungroup selected objects. 

The Edit Group button allows you to change objects within group using a special window for edits.

Properties
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Shape  

ConceptDraw DIAGRAM gives the opportunity to work with the object properties. You can change the
default object properties, and define your own, custom properties.

Shape Properties - Activate the Shape Properties dialog. This dialog is used to modify
the default properties of an object.

Custom Properties - Edit object's custom properties using the Custom Properties
dialog or define them using the Define Custom Properties dialog.
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Shape Text

Text

 Text

Fit to text: Make the sizes of object appropriate to the text size

Text Handle: Add text handle to change alignment of text inside object

Text Bound: Set text boundaries within the object
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Shape Operations

Operations

Edit Vertex: Activate this tool to  see the vertices of the object.  You can change the form of
object  by dragging the vertex. Drag the vertex where you want it and then release the mouse
button.

Add vertex: ConceptDraw DIAGRAM provides vertices on all its objects, but there may not be
enough for your purposes. You can add your own vertices. Select an object and use the Vertex
tool to add vertex to the shape. The cursor will look like a crossed circle. Left mouse-click to
add vertex to the shape. Change the shape form by dragging the vertex.

Cut Edges: Cut the object's edges.
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Shape Operations

  Operations: Click the drop-down button to access the full list of available operations with
objects      containing in the Basic Shapes library

   

Union: Create an object from the perimeter of multiple overlapping objects. Apply the Union tool only to
shapes with enclosed geometry. 

     Before     After

Combine: Combine the selected objects into a solid multi-component object.

    Before      After 

Fragment: Cut out the overlapping portions of multiple shapes based on intersecting lines with  primary
shape in multiple selection.
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Shape Operations

   Before     After

Difference: Divide multiple objects into smaller parts based on intersecting lines or overlap and cut out
the overlapping portions.

 Before     After

Subtract: Create an object by subtracting from the primary selected object the areas where subsequent
selected objects overlap. 

 Before     After
Extract: Create an object by subtracting from subsequent selected objects the areas where the primary
selected object overlap.

 Before      After

Intersect: Create shapes from the areas where multiple shapes overlap with the primary selected shape.
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Shape Operations

 Before    After

Separate: Separate combined objects.
Section: Create multiple shapes by cutting the selected shapes along the cut line created with the Line
tool. The Line should be a primary object in the selection.

Before   After

Join: Join selected objects into a single shape, if they are unclosed figures. For example lines, arcs
e.t.c. If they are closed figures such as rectangle or circle, this command will act the same as the
Combine command. 

             Before                       After                       
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Document  

Document

Page
Manage

Add page: Add a blank page at the end of the document

Delete Page: Delete page from the document

Page Navigator: Activate Pages panel

Page
Navigate

Page navigation controllers: Buttons to scroll pages

Page
Backgrou

nd
Create Background: Add new page and set it as background page for the current
page or for all pages.

Set as Background : Set the selected page as a background to other pages. By
default, the new page is not a background page

Choose Background: Assign a background for the selected page from a list of all
document's pages. By default, the new page has no background

Page
Size

  

Orientation: Switch  page between portrait and landscape layout.

Width: Change page width.
Height: Change page height.
Lock proportions: Keep page proportions when changing page size.
Adjust to Content: Apply thee page size to fit page content.

Size: Select a page size or a  display size using the drop down list. 
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Document  

Settings
Snap&Glue (Ctrl+Shift+U): Open the Snap&Glue dialog. Press and hold ALT to switch off
snapping when drawing or moving objects.

Grid & Rulers (Ctrl+Shift+G): Open the Grid&Rulers dialog.

Connectors Routing 

Change the type of connector crossing.

Square

Arc

Triangle

Trapezoid

Dash line

Change the layout of gap between connectors

 

Horizontal layout

Vertical layout

Crossing with no gaps
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View  

View

Side
Panels

Libraries - Activate the Library panel

Layers - Activate the Layers panel 

Info - Activate the Info panel

View   

 

Rulers - Show/Hide rulers

Grid - Show/Hide Grid

Guides - Show/Hide Guidelines

Page Breaks - Show/Hide Page Breaks

Size Sizes - Show/Hide an object dimensions  using editable size boxes

Shape Controls - Show/Hide an object functional buttons.

 
Zoom   

Zoom In - Zoom in on the document.

Zoom Out - Zoom out of the document.

Zoom to
Whole
Page
(Ctrl+Shift+
0) - 

Zoom document so that  the page fills entire window

Zoom to all
Objects

Zoom document so that  all objects  are visible

Zoom Box
- 

Zoom in on the document so that selected area fills entire window
Press and hold ALT to Zoom out of the selected area.

Scroll
Hand - 

Activate the Scroll Hand tool that allows one to easily move the page.
Hold on the right mouse button to move page.

Zoom - 
Choose a standard  level within the 50% - 400% range,  or set  "Whole Page ",
'Page Width" or "All Objects".
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View  

Windows & Panels   

Panels
- 

Activate the Floating Dialogs panel

Output - Open Output panel  

Library - Open Library panel

Solutions -  Open Solutions panel

Pages -  Open Pages  panel

Layers  - Open Layers panel 

Arrange - Open Arrange panel

Format - Open Format panel

Hypernote -  Open Hypernote panel

Presentation - Open Presentation panel

Info - Open Info panel

Custom Properties - Open Custom Properties panel

Advanced - Open Advanced panel

Output - Open ConceptDraw Basic Editor  window

Colors - Referred to the Colors panel on the bottom of application

window.

Status Bar - Show Status Bar

Restore Panels State -  Restore the default Panels view

Window 

New Window - Open a new window containing the current document.

Cascade Windows - Cascade  arrangement of opened windows.

Tile Windows Horizontally - Horizontal arrangement of opened

windows.

Tile Windows Vertically - Vertical arrangement of opened windows.

Close (Ctrl+W) - Close an active window.

Close All - Close all open windows.
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View Functional Buttons

Functional Buttons

A set of function buttons becomes available when you select an object. These buttons provide quick
access to some operations that can be carried out with the selected object. 

The Action button .

Some objects supplied in the DIAGRAM libraries can change their appearance, or behavior, thanks to
predefined actions. Such objects can be edited by using the menu which is called by clicking this
button.
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The Hypernote button .

Activate the Hypernote side panel to manage text notes and hyperlinks added to the object.

The Custom Properties button .

Activate the Custom Properties side panel  to view and edit the object's custom data.

The Smart Connector button .
Activate Smart Connector. To connect objects using this tool, drag the connector a connect point of
another object. You can change the connector's type using the options provided in the Format side
panel.

The Delete button .

Use this button to remove the selected object from a document page.
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Share  

Share

 

Panel  

Presentation: Open Presentation panel

Email

Send via email: Send a copy of the current document in an email message as an
attachment

Exports
 

Adobe Flash:  Save document as Adobe Flash (SWF) file, using Flash Export Settings
dialog

PDF: Save document as Adobe Acrobat (PDF) file

EPS:  Save document as Encapsulated PostScript (EPS) vector file

Graphic File: Save document as graphic file (emf, bmp, dib, gif, jpeg, jpg, png, svg,  tif,
tiff)

HTML: Save document as HTML file

MS PowerPoint: Save document as Microsoft Office PowerPoint 97-2003 Presentation
(.ppt)

MS Visio (VDX): Save document as Microsoft Visio 2003-2010 Drawing (.vdx) file

MS Visio (VSDX): Save document as  Microsoft Visio Drawing (.vsdx) file

SVG: Save document as  SVG file
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Developer  

Developer

Developer tab is used to operate with ConceptDraw Basic Script. It is disabled by default. Use the View
tab in the Options dialog to activate it. 

Each ConceptDraw graphical object has a set of properties that define its appearance and possible
actions
There are two major ways to manage the graphic content of ConceptDraw DIAGRAM documents:
· Shape Parameter Table
· ConceptDraw Basic Script

ConceptDraw Basic Script is used to create and work with complex objects containing a variable number
of components, custom properties, and types of behavior. ConceptDraw Basic Script allows setting
interaction with other applications (run from the command line, invoke custom functions from external
libraries).

The application, document, page and even object can contain a ConceptDraw Basic Script. This means
that any document, page or object, can contain some program written in ConceptDraw Basic script.
Script at any level is compiled and run at start-up of the corresponding object. Initially, the application is
loaded. The primary level of the script execution is the Application level. When you download a
document, first run a Document script, then Page script and finally the Shape script.
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Developer Shape Parameters Table

Shape Parameters Table

The Shape Parameter table provides the opportunity to work with a pre-defined set of object parameters

and properties. You can access it using the Power Edit button  on the Developer tab. 
With the help of the Shape Parameter table, you can define the logic of objects behavior, apply an
arbitrary appearance to them, set relationships between the appearances of different objects and create
composite objects. You can manage the tables sections using   Insert Table Section  and View Sections
dialogs.

For more complex objects, objects with a variable number of child elements and custom

properties, as well as a predetermined behavior  ConceptDraw Basic script is recommended. 
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Modal Dialogs

These dialogs are mostly called from the menus, or by using the keyboard shortcuts. While this dialog is
open, you can't work with other dialogs or tools. As a rule, modal dialogs have several standard buttons:

OK - closes the dialog and applies the changes.
Cancel - closes the dialog without applying the changes.
Apply - applies the changes without closing the dialog.
Help (?) - displays context help.

The settings are not applied until you click the OK or Apply buttons.
Color 
Define Custom Properties
Edit User
Find/Replace
Flash Export Settings
Grid&Rulers
HTML Export Wizard
Image Properties
Insert Table Sections
Library Item Properties
Library Properties
Login
Open
Page Properties
Paste Special
Save
Shape Properties
Snap and Glue Settings
Spell Check
Text Properties
View Sections
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Color  

Color

This dialog is used to set color for a shape, its text or other attributes.
You can call this dialog by choosing the Other... from the appropriate button of Format panel .
 
The Color dialog:
 

To choose the needed color, click on it with the mouse.

Current - shows the currently chosen color.
Old - shows the color being changed.

You can specify a color manually in one of the two available color schemes: RGB or CMYK. The
currently chosen scheme is shown in the drop-down list:

- RGB Scheme
- CMYK Scheme
The R(ed),G(reen),B(lue) or C(yan),M(agenta),Y(ellow),(black)K slide bars allow to change each
component of the color scheme.
Note: In the RGB Scheme the color components may range from 0 to 255; in the CMYK Scheme the
components are shown in percents and may range from 0 to 100

A slider allows you to add transparency to your objects in order to make them more attractive or if you
want to see objects located under. Move slider to the right to increase the transparency of the object and
to the left to decrease it.
System - calls the system color dialog.
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Define Custom Properties 

Define Custom Properties

This dialog is used to create, modify and delete custom properties of a shape. This dialog can be called
by clicking the Define button in the Custom Properties dialog or by clicking on Custom Properties button
on the Shape tab if custom properties are not defined yet. The Define Custom Properties dialog:

The Properties section in the lower part of the dialog contains a list of custom properties of the shape. To
modify or view a property in the upper part of the dialog, click on its name in the list.

New - creates a new property and adds it to the list.
Delete - deletes the property, selected in the table.

Each custom property is described by the following fields:

Label - the name of the property. It's used when the property is referenced to in formulas or CD Basic
scripts.
Type - the type of the property, can have one of the following values:

String
Number
Fixed List
Variable List
Boolean

Note: The information about the type is used in the Custom Properties dialog: when entering values of
the Fixed List, Variable List or Boolean types you're offered to choose one from the list. Also information
about types can be used by CD Basic.

Format - contains the list of possible values for the properties that have the Fixed List or Variable List
types. The values are delimited by semicolon ";". For values of other types this parameter is ignored.
Value - indicates the default value,
Prompt - the text of the tip,
Invisible - specifies whether to show this property in the Custom Properties dialog,
Verify - if enabled, checks if the property has a value, and if it doesn't, the user will be asked to provide
one.
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Edit User  

Edit User

This dialog is used to edit user details. You can limit access to the document to authorized users only.

This dialog is called when you click the Add User or Edit User buttons in the Advanced tab of the
Properties dialog.

The Edit User dialog:

User - the name (login) of the user.
Password - the password. It can contain any symbols. The password is case-sensitive.
Confirm password - enter the password here to confirm it.
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Find/Replace  

Find/Replace

This dialog allows you to search for and replace text in ConceptDraw shapes. The search can be
performed either in the current document, or in the documents on disk (including folders and sub folders).
You can edit the document without closing this dialog - it remains floating over the document, and you
can always return to it and search for the next match.

You can call the dialog from the Home tab button  or by using the keyboard: Ctrl + F

 Find/Replace dialog

Find what - here you can specify the string to be found. You can either type the text, or select one of the
previously searched strings.
Replace with - a string with which the found string will be replaced.
Match Whole Word - search only complete words. For instance, if "leg" is being searched, the "leg"
world will be found, and "legion" and "legend" will be ignored.
Match Case - specifies whether to differentiate capital and small letters in the search.
Search All Pages - specifies whether to search on the current page, or on all pages of the document. By
default only the current page is searched.
Search Backwards - searches in reverse direction.
Search Linked - specifies whether to search in the hyperlinked pages and objects.
In Folder - search in all ConceptDraw located in the folder, specified in Path. All open documents that
are not in the Path folder are ignored.
Path - specifies the path to the folder, where the search will be performed. You can type it manually, or
choose by using the Browse button.
Look In Sub folders - specifies whether to search in sub folders of the folder, indicated in Path.
Find Next - finds the next match. If the match is found, the text editing mode is turned on and the found
text gets highlighted. If the In Folder or Search Linked options are enabled, and a match is found in one
of the non-opened documents, the document will be opened automatically.
Replace - replaces the found string with the string in Replace with.
Replace All - replaces all matches with the string in Replace with.
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Flash Export Settings 

Flash Export Settings

This dialog is used to configure the parameters of the resulting .swf file when exporting the document to
Macro media Flash format.

This dialog is called from the menu File /Export/Adobe Flash, or from the Share tab.

Flash Export Settings dialog

 

The Slide Show setting specifies when the next page of a multi-page document will be displayed:

None - only the first page is displayed.
Mouse Click  - the next page will be displayed on a mouse-click.
Timer - the next page will be displayed in the specified time interval (in seconds).

Use Navigation Buttons the following navigation buttons will be inserted into the Flash file:
Go to first page
Go to previous page
Go to next page
Go to last page
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Grid&Rulers  

Grid&Rulers

This dialog is used to configure the view of the grid and the rulers.

This dialog can be called from the Grid&Rulers button  on the Document tab,  or with the
keyboard: Ctrl + Shift + G
Grid & Rulers dialog

The Rulers Origins -sets the starting point (origin) for the rulers. The origin represents the horizontal and
vertical offset relative to the upper left corner of the page.

Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.
Vertical - vertical offset. The possible range is -320 mm to +320 mm.

The Grid Origins -sets the starting point (origin) for the grid lines. The origin represents the horizontal and
vertical offset relative to the upper left corner of the page.

Horizontal - horizontal offset. The possible range is -320 mm to +320 mm.
Vertical - vertical offset. The possible range is -320 mm to +320 mm.

The Grid Spacing section specifies the size of the grid cells.
Horizontal - sets the width of the grid cells:

Normal
Fine
Coarse
Fixed.

The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
Vertical - sets the height of the grid cells:

Normal
Fine
Coarse
Fixed

The Fixed option allows to input a custom value within the 0 mm to 320 mm range.
The Grid Color section specifies the grid color and alpha channel settings of the grid.
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Grid&Rulers  

The Alpha channel controls the transparency/opacity of a grid color.  
The maximum opacity:

The maximum transparency:
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HTML Export Wizard 

HTML Export Wizard

This dialog is used to set exporting parameters for HTML.

Access dialog from the Export item in the File menu

 
There is a gallery of templates in the top part of the dialog. To choose a template make a click on its
icon. To export the current document with the default settings make a double-click on chosen template
icon.
 
Process linked ConceptDraw documents - process all linked ConceptDraw documents like the
current document, so you will be able to open them as regular HTML files from the exported HTML file.
Export current page only - exports only current page of the document.
Export pages as image - exports the content of ConceptDraw document as *.png image inserted into
html page
Open exported page - opens exported HTML file after export using default Web-browser.
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Image Properties

This dialog is used to configure export settings of ConceptDraw shapes to other graphic formats. This
dialog can be called from the File / Export / Graphic File menu, or from Share tab. Image Properties
dialog.

In the Image Size section, you can choose one of these options:
Original size - the shapes will be exported in their original size, regardless of the current zoom level.
Use zoom - the shapes in the graphic file will bfile woulde of the same size as they appear on screen
(at the current zoom level).
Fit to size(pixels) - this option lets you assign custom dimensions to the picture - specify the width
and height in pixels.
High quality - choosing this option, you'll get the best quality image. Please note, that the size of the 
increase. We recommend to use the option for printing.

In the Export section, you specify which  shapes will form the image in the graphic file:
Whole page - to export the entire page with all the shapes which are within the page.
All objects on page - all the shapes which are on the page and outside it. The image size will be large
enough to fit for all shapes.
Selected  objects - only the selected shapes from the active page. The image size will be equal to
the total bound of all selected shapes.
All document pages - select when export to animated GIF.
Time interval (GIF) - set the time interval to show the animated GIF slides.
Quality - for JPEG format you can also specify image quality: by using the slide bar, you can set the
quality within the range of 1% to 100%. Note that better quality increases the file size.
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Insert Table Sections 

Insert Table Sections

This dialog is used to insert new sections in the Shape Parameter table.

Insert Section dialog:

In the dialog you can choose which sections are to be added in the table:
Geometry - adds a new Geometry section. It's available for all shapes except groups.
Control handles - adds the Controls section, that describes control handles. A shape
can have just one Controls section.
Connection points - adds the Connection Points section, that describes connection
points. A shape can have just one Connection Points section.
Variables - adds the Variables section, that describes user-defined variables. A shape
can have just one Variables section.
Actions - adds the Actions section, that describes user-defined actions. A shape can
have just one Actions section. The first 15 actions are available from the shape's context
menu.
Custom Properties - adds the Custom Properties section, that describes user-defined
data. A shape can have just one Custom Properties section.
Text - adds the Text section, that describes the text properties. A shape can have just
one Text section.
Data Sources -  adds the Data Sources section, that describes the three-side data
sources properties. A shape can have just one  Data Sources section.
Data - adds the Data section, that describes the Data properties. A shape can have just
one Data section.
Rapid Draw Object - adds the Rapid Draw section, that describes the Rapid Draw
properties. A shape can have just one Text section.
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Library Item Properties 

Library Item Properties

This dialog is used to view and set the properties of library shapes. You can call this dialog by clicking
Properties in context menu of Library object in the Library window.
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Library Item Properties 

The Library Item Properties dialog:

Name - contains the name of the library shape.
Prompt - contains a brief description of the library shape.
Keywords - contains comma separated keywords - words or phrases  that  can be used when  searching
the library object.
These properties are displayed when you position the mouse pointer over a shape in the library. The Item
name appears as a tip over the shape, and the Item prompt is shown in the status bar.
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Library Properties  

Library Properties

This dialog is used to view and set library properties. You can call this dialog from File / Library /
Properties or from the context menu in the library window.
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Library Properties  

The Library Properties dialog:

Title - the name of the library.
Keywords - contains comma separated keywords - words or phrases  that  can be used when  searching
the library.
Author and Company - information about the creators of the library.
Description - Short description of the library content.
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Page Properties

This dialog is used to view and the page properties.

You can call this dialog from the Page Navigator menu (View tab/Panels/Pages) 

The Page Properties dialog:

Title - the name of the Page
Description - Short description of the page content.
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Login

This dialog asks user login and password for documents with protected access. It appears when you try
to open a protected document. If such user name and password are not authorized to view the
document, the document is not opened.

The Login dialog:

User - the name (login) of the user.
Password - password.

Note: To protect the document and specify authorized users, use the Properties dialog, the Advanced
tab.
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Open

This dialog is used to open ConceptDraw documents and to import documents of supported formats.The
dialog can be called from the File / Open menu, or by using the keyboard: Ctrl + O. The dialog is also
called when importing files .

Open dialog

 In this dialog you can choose to show only files of the desired type. In the list, choose the document
you want to open, and double-click it with the mouse. To select more than one document, hold down the
Shift or Ctrl keys.
Open - opens selected documents.
Cancel - closes the dialog.

Note: By default, this dialog shows only ConceptDraw DIAGRAM files. To show files of other types,
choose the corresponding type in the drop-down list.
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Paste Special

This dialog is used to insert various objects from the Clipboard into a ConceptDraw document.

This dialog can be called from the Home/ Paste Special menu.

The Paste Special dialog:

Source - indicates from where the object was copied.

As - offers available formats in which the object can be pasted. Depends on the current buffer content.

Paste - the object will be embedded into the ConceptDraw document and will be stored together with it.

Paste Link  - pastes a reference to the object, rather than the object itself. When the source file is
changed, the object in the ConceptDraw document will be changed respectively. Only a link to the object
is stored with the document.

Result - explains what will happen when you insert the object in the selected format.

Display As Icon - specifies whether the object should be displayed as icon, or in its original form.

Result - explains what will happen when you insert the object in the selected format.
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Save  

Save

This dialog is used to save documents, templates, workspace files and files of other formats, exported by
ConceptDraw. This dialog can be called from the File menu by the Save  (Ctrl + S) item (if you save the
file for the first time), Save As (Ctrl + Shift + S),  Save As Template,  commands or by using the
keyboard. This dialog is also called when you export files.

Save dialog

Depending on the command you use to call the dialog, you get different save options. When you use the
Save and Save As commands, you can save in one of the following formats:

· CDDZ (ConceptDraw Document )
· CDD (ConceptDraw Document v7-9)
· CDS (ConceptDraw Presentation ) 
· CDT (ConceptDraw Template)

If you use the Save As Template..., command, you'll be able to save a template  file respectively. To save
files in other formats, use the File / Export menu.
Save - saves the document.
Cancel - closes the dialog.
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Shape Properties

This dialog is used to modify properties of a shape. You can call this dialog from the Shape tab, from the
context menu or by using the keyboard: Ctrl + Shift + C

The dialog includes the following tabs:
Information - contains basic information about the selected shape.
Behavior & DoubleClick - determines how the shape interacts with other shapes, allows to
protect some parameters from changing. Also it allows to assign an action that is performed
when the shape is double-clicked.
Lock - allows to protect some properties of the shape from changing.

 Information tab

When more than one shape is selected, it displays information for the primary selected shape.
ID - indicates the unique number of the shape in the current document.
Sub ID - indicates the number of the shape in its parent group. It's used for referring to shapes inside a
group.
Name - in this field you can type the name you want to assign to the shape.
Layer - assigns the shape to a layer.
Description - here is the short description of the object and the name of its parent library
Keywords - in this field you can enter the keywords which the search engines will use to  include the
given shape in their search results.
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Shape Properties  

Behavior & Protection tab

Interaction Style section determines whether the shape is a connector or not, and lets you turn any
shape into a connector if necessary:

Line(1-D) - the shape behaves as a line - it has a begin and end point (is a 1D-shape). Such
shape can be used as a connector.
Box(2-D) - the shape behaves as a 2D-shape, that is, it has width and height.

Selection Highlighting section describes how the shape is displayed when selected. The following
options are available:

Show shape handles - display or hide the handles on the shape's alignment box. This option is
on by default.
Show control handles - display or hide the control handles of the shape. This option is on by
default.
Show alignment box - display or hide the shape's alignment box. This option is on by default.

 Resize Behavior section describes how the shape behaves within a group when the group is resized:
Scale with group - always resize the shape as the group is resized. This option is set by default.
Reposition only - simply move the shape without changing its size.
Use group's settings - the shape uses the behavior settings of the group to which it belongs.
Save original scale - if this option is on, the shape will keep its size when inserted into a
document with some other scale. Otherwise, the size of the shape will be changed according to
the scale settings of that document.

Group Behavior section describes how the group behaves:
Enable group's text - allows the group to have its own text.
Select group only - sets whether you can select shapes inside the group.
Reverse selection - changes the order of selecting a group and objects within a group (by
default, the first click selects the group and, the second - the object)
Only works if item "select group only" is toggled off

The Double Click  section  specifies the action, performed when the shape is double-clicked:
Perform no action - nothing happens.
Edit shape's text - turn on the text editing mode.
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Edit shape's table - display the shape parameter table.
Edit group in new window - open the Edit Group window, where you can edit the shapes inside
the group (this option is only available for groups).
Go to hyperlink  - open the hyperlink (available if the shape has a hyperlink).
Action - perform a user-defined action. Two modes are available: you can choose an action from
the list, or choose. 
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 Lock tab

The Lock section allows to protect some properties of the shape from changing.
Fill - lock the fill options changing.
Line - lock line changing.
Width - locks/unlocks the shape's width against resizing.
Height - locks/unlocks the shape's height against resizing.
X position - locks/unlocks the horizontal (X) position of the shape.
Y position - locks/unlocks the vertical (Y) position of the shape.
Aspect ratio - if on, the ratio between the width and height is always preserved when the shape is
resized.
Begin point - for 1D shapes, locks/unlocks the begin point against repositioning.
End point - for 1D shapes, locks/unlocks the end point against repositioning.
Rotation - locks/unlocks the shape against rotation.
Vertex - locks/unlocks the shape against applying of the Edit Vertex tool.
Flip X locks/unlocks the shape against flipping horizontally. 
Flip Y locks/unlocks the shape against flipping vertically.
Deletion - locks/unlocks the shape or its vertices against deleting.
Show text - sets whether to display the shape's text.
Don't print -sets whether the shape can be printed.
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Snap and Glue Settings

This dialog is used to configure the snapping and gluing settings. You can call this dialog from the

Document / Snap&Glue button   or by using the keyboard: Ctrl+Shift+U

If Snap to is enabled, you can specify the conditions when snapping will be activated:
Objects - the shape will snap to the closest objects using dynamic guides as shown in the picture
below.

Ruler Subdivisions - the shape will snap to the imaginary lines coming out of the rulers' subdivisions.
Use this for very precise positioning.
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Grid - the shape will snap to the grid nodes.

Guides - the shape will snap to the guide lines.

Geometry - the shape will snap to the outlines of other shape. It is usually helpful when you need to
attach a shape to another shape.
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Shape Handles - the shape will snap to resize handles of other shapes.

Vertices - the shape will snap to vertices of other shapes.

Angles - Snap to  dynamic guides during rotation of object to  a multiple of 45 degrees.

Connections Points - the shape will snap to connection points of other shapes.
Glue to Guides - allows shapes to glue to guide lines. 
Snap sensitivity (the distance from which snapping is activated) can be set in the Options dialog, the
General tab.
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Spell Check

You can use the Spell Check dialog to find mistakes in the shapes text. You can call this dialog  using

the spelling button   on the Home tab.

When you call the dialog, the Spell Check engine checks all objects in your document at all pages. You
will see the results of the check in the next dialog.

The mistakes are marked red and underlined. You can select one of the words from the internal
dictionary and correct a mistake by pressing the Change button, ignore a mistake by pressing the
Ignore button , ignore all mistakes by pressing Ignore All button, or add a word to the User Dictionary
by pressing the Add button. To change an existing word you need to select it, correct it and press the
Change button. You can also delete words from the User Dictionary. To delete a word you need to
select it and press the Delete button.
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Text Properties

You can use the Text Properties dialog to set or modify various attributes of the shape's text. You can
call this dialog from the context menu of the selected object, or by using the keyboard: Ctrl + Shift + T.
When you call the dialog, three situations are possible:

1. One of the shapes is in the text editing mode - the all changes will be applied to the selected
text in the shape.

2. One or more shapes are selected - the changes will be applied to the whole text of the
selected shapes.

3. None of the shapes is selected - the changes are applied to default settings for new shapes.

The Text Properties dialog contains the following tabs:
Font - specifies the font, font style and other attributes,
Paragraph - specifies various paragraph properties. The end of a paragraph is denoted by the
linefeed character (inserted with the Return (Enter) key),
TextBlock  - sets text block parameters of the shape,
Tabs - allows to add, delete or modify tab stops. 

 Font tab:

Font - allows you to choose a font from the list of installed fonts.
Language - sets the language (encoding) for characters. It's required to exchange documents with
applications which don't support Unicode, and with ConceptDraw 1.x.
Size - specifies the font size in points. 1 point = 1/72 inch.
Color - sets the text color. You can choose a color from the color palette, or set a custom color.
Spacing - specifies how much to increase or decrease the distance between characters (in points). Enter
0 for normal spacing, a positive number - to increase spacing, a negative number - to decrease spacing.
The Styles allows to apply one of the following styles to font: Bold, Italic, Underline, Strikethrough,
Superscript, Subscript.
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Paragraph tab

The Horizontal Alignment section describes how the paragraph is aligned relative to the shape's text box.
The following alignment types are available:

Left - to the left side of the text box,
Centered - the lines are justified with respect to the center of the text box.
Right - to the right side of the text box.

The Indentation section allows to set indents for the paragraph in millimeters or inches (depending on the
measurement system of the document).

First Line - specifies the indent for the first line of the paragraph,
From Left - specifies the left indent for all lines of the paragraph,
From Right - specifies the right indent for all lines of the paragraph.

In the Spacing section you can set the distance between the lines of text. The distance is specified in
points (though you can use other units of measure too). A positive value increases the distance, a
negative value - decreases the distance.

Before - changes the spacing between the current and the previous paragraphs,
After - changes the spacing between the current and the next paragraphs,
Line - changes the distance between the lines for all selected paragraphs. When you set the
value in percent (120%,150%, etc) the spacing will be based on the font size. Also, you can set
a fixed value in points. The default value is 100%.
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 TextBlock tab

 The Vertical alignment section determines how the text block is positioned relative to the shape's text
box:

Top - moves the text to the top of the text box,
Middle - centers the text in the middle of the text box,
Bottom - moves the text to the bottom of the text box.

The Margins section describes margins for the text block (the margins are specified in millimeters or
inches depending on the measurement system of the document).

Left - specifies the left margin for the text block,
Right - specifies the right margin for the text block,
Top - specifies the top margin for the text block,
Bottom - specifies the bottom margin for the text block,

Text Background allows to choose a background color for the text.
Transparent sets transparent background for the text (this option is on by default).
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Tabs tab

The Tabs table contains the list of current tab stop positions. The left column shows the tab position, the
right one specifies the alignment type with respect to the position.
Tab Stop Position area allows to modify the tab position, selected in the Tabs table.
Default Tab Stop - specifies the default tab position for the entire shape. By default, it's 1/2 inch.
The Alignment section specifies how text is aligned with respect to the tab position:

Left - places the left edge of the text in the specified position,
Center - places the center of the text in the specified position,
Right - places the right edge of the text in the specified position,
Decimal(.) - if there's the point separator (.) in the text, the text is aligned by the point.
Comma(,) - if there's the comma separator (,) in the text, the text is aligned by the comma.

The picture below demonstrates possible types of alignment:

Tab stop positions are shown with red lines.

Add - adds to the Tabs list the tab stop described in Tab Stop Position. For convenience, after you click
the Add button, the setting in the Tab Stop Position area is increased by the value of Default Tab Stop.
Modify - replaces the settings of the tab stop selected in the Tabs list with the settings, displayed in the
Tab Stop Position field and in the Alignment section.
Remove - removes the tab stop position selected in the list.
Remove All - removes all tab stops from the list.
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View Sections

This dialog is used to display or hide existing sections of the Shape Parameter table. If the
corresponding option is enabled, the section is visible, otherwise - it is hidden. View Sections dialog:

Object Transform - display/hide the Transform section.
Geometry - display/hide the Geometry section.
Line Format - display/hide the Line Properties section.
Fill Format - display/hide the Fill Format section.
Protection - display/hide the Protection section.
Miscellaneous - display/hide the Miscellaneous section.
Connection Points - display/hide the Connection Points section.
Control Handles - display/hide the Control Handles section.
Variables - display/hide the Variables section.
Text Transform - display/hide the Text Transform section.
Character Format - display/hide the Character Format section.
Paragraph Format - display/hide the Paragraph Format section.
Text Block  Format - display/hide the Text Block Format section.
Text Tab Stops - display/hide the Text Tab Stops section.
Text Fields - display/hide the Text Fields section.
Actions - display/hide the Actions section.
Custom Properties - display/hide the Custom Properties section.
End Points - display/hide the End Points section (available for 1D shapes and
connectors only).
Glue Info - display/hide the Glue Info section (available for 1D shapes and connectors
only).
Data Sources - display/hide the Data Sources section.
Data - display/hide the Data section.
Rapid Draw Object - display/hide the Rapid Draw Object section. 
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Floating Panels

Some tools and features in ConceptDraw DIAGRAM are accessible from the floating panels. You may
find here particular tools and resources  that you might need while working with graphic documents.

Click the button  on the View tab to find a needed panel in the drop-down list.

    

Output
Library
Solutions
Pages
Layers 
Arrange
Format
Hypernote
Presentation
Info
Custom Properties
Advanced 
Colors 
Status Bar
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Library

You can call the dialog from the View  tab by clicking the Libraries button or using the  Panels
list.
Wide collections of shapes and Clip arts help you create a different types of diagrams, as well as various
sorts of technical drawings.

.1. Libraries section  displays the opened libraries. You can cause a list of opened libraries by using
the drop-down button. 

Press the navigation arrows   to navigate through libraries.

Press the Close icon  to remove a library from the Library panel.

You can manage the libraries using the context menu and Library Properties Dialog
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2. Objects section displays objects containing in the active library. 

There are a few different methods for placing an object into your drawing:
· Click on an object and then click on the document, at the place you want the object to be inserted.
· Perform a drag-and-drop from the library to your document.
· Double click on an object’s icon in the library to place an object in the center of your document.
You can manage library objects using the context menu and Library Item Properties dialog.
Some of ConceptDraw libraries contain objects, identified by a blue tile in the library preview on the
Solutions panel.
 

Such objects added to a document page can be edited by using the Action button   menu. To open
the menu select an object and click the action button in the upper right corner of the object.
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Solutions

ConceptDraw DIAGRAM provides an  access to an online service  that  delivers  additional product
extensions. This is a time saving assistant for generating business documents and presentations.
ConceptDraw Solution Park is an online collection of visual solutions for  ConceptDraw products. It
contains many subject areas for professional applications. Solutions panel provides the list  of available
solutions in alphabetical order.Access the panel from the Home tab, or using the  Panels list at the View
tab.

1. Search window.  You can search for library objects. Enter a keyword or an object name in the
search field. The object will be found and displayed in the Library panel, also solutions displayed in the

Solutions panel will be filtered according to the keyword.

2. Search in ConceptDraw STORE. You can run the  STORE to search for the the proper solution in
Solution Park 

3. Solution section. This section contains the list  of available solutions in alphabetical order. 
The following options are available here:
a) Use the drop-down button to preview Libraries, Templates and Samples contained in the certain

solution. You can open them by click. A library context menu appears when you right-click a library
preview. It helps you to interact with libraries. 

b) Click to purchase paid solutions using the ConceptDraw STORE application. 
c) Click to download and install a free, or previously purchased solution using  the ConceptDraw

STORE application.
d) Check, to view just solutions that are already installed. 
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.
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Pages

Access the panel from the Panels list at the View tab. Work with pages of a current document.

 

The active page preview. Double-click name to rename page.

 

Page has background

 

Page is assigned to be background page

You can operate pages using the page context menu.  Access it from the  button. 
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Layers

You can call the dialog from the View  tab by clicking the Layers button or using the  Panels list.

Dialog shows layers and allows changing of properties

Layer's Name Double-Click to rename

    ( ) Visible (Invisible) On/Off  Layer visibility

      (   ) Unlocked (Locked) Enable/Disable editing  Layer

Printable Enable/Disable printing objects of Layer

Layer's Color Change the Line Color of all objects  on
Layer
On/Off color changes with check

Active Layer You can change any properties of this
Layer

Add Layer Add new Layer

Delete Layer Delete the current Layer

Select Objects on Layer Select all objects on current Layer
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Arrange & Size

ConceptDraw DIAGRAM provides tools to help ensure the shapes in your diagram are aligned and
spaced well. That helps make your drawing as clear as possible and give it a professional look. Access
the Arrange & Size panel from the Home tab, or using the  Panels list at the View tab.

· Order
Here are object order tools. They help you control the placement of overlapping objects.

· Align and Distribute
Align shapes without changing their spacing using the Left, Central, Right controls to set a horizontal
alignment and Top, Middle and Bottom controls to set a vertical alignment.
Distribute the space between object's control frames using the Vertical and Horizontal distribution. 

· Size
Set the size of the object in the units specified in the Options.

· Position
Set the position of the object in the coordinate system. 
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· Rotate and Flip
You can rotate objects rotated clockwise and counterclockwise in 90 and 180 degrees . You can  flip
them vertically, flip them horizontally, or rotate using the Angle and Pin.

· Group and Lock 
You can group Group and Ungroup selected objects. The Edit group button allows you to change
objects within group using a special window for edits.. 

· Make Same
You can make the certain properties of selected objects identical.
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Format

In ConceptDraw DIAGRAM you can customize the appearance of objects by changing their fill colors,
line weight and style, text colors and fonts. Access the Format panel from the Home tab, or using the 
Panels list at the View tab.  Format panel has different appearance depending on the object selected.

Format panel for a Library object

  

· Style
You can apply pre-designed formatting to your drawing with one click. The embedded style themes can
be applied to an entire object (fill, line and text) or to object's elements, such as line, and text. You can
create your own style containing custom colors, effects and text formatting by choosing one of the
embedded styles and modifying it. 
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You can save a new style in your current ConceptDraw DIAGRAM document, or save it on your local

computer to be used with other ConceptDraw DIAGRAM documents. Use the icon to save , or load
custom themes.

· Fill
Change the fill color of selected object.

· Border
Change line color and line pattern.

· Shadow
Select shadow style and color.

· Make Same Attributes
Make certain properties of selected objects identical.
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Format panel for a Connector

· Style
Built-in style themes can be applied to connectors as well as to entire objects (fill, line, and text). You
can apply pre-designed formatting to your drawing with one click. The embedded style themes can be
applied to an entire object (fill, line and text) or to object's elements, such as line, and text. You can
create your own style containing custom colors, effects and text formatting by choosing one of the
embedded styles and modifying it. 



Floating Panels

ConceptDraw DIAGRAM  User Interface Reference © 2020 CS Odessa corp.

95

Format  

You can save a new style in your current ConceptDraw DIAGRAM document, or save it on your local

computer to be used with other ConceptDraw DIAGRAM documents. Use the icon to save , or load
custom themes.

· Connector Type
Change the type of connector.

· Stroke
Change the type of the stroke of the selected connector.

· End Points
Change the form and size of the arrowheads of the selected connectors.

· Margins and Path
You can  create connectors that do not have a visible connection to
the objects by adding two-sided margins, or one-sided indents - path.

· Make Same Attributes
Make certain properties of selected objects identical.
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Hypernote

Use this panel to assign text notes and  hyperlinks. You can add hyperlinks to any ConceptDraw object.
The hyperlinks can link to another page or object in the current document, or a Web site. Access the
panel from the Panels list at the View tab. or from context menu of the object.

 

Hypernote dialog

· Title
Click to enter the Title of Hypernote

· Hypernote
Click to enter text Notes.

· Hyperlinks
Click to add a hyperlink using the Set
Hyperlink  dialog. 
You can edit hyperlinks using context
menu.
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Set Hyperlink

Hyperlinks  can be of the following types: a hyperlink to an Internet address, files, or to a page/object
in the current document..
Link to Web - you can add one or more hyperlinks  to an Internet address. When such link is opened,
the program launches the default browser and goes to that address. You can type the hyperlink
address manually, or and copy and paste the link from the Internet browser.
Link to FILE - you can add a hyperlink to other files on your computer or the ones accessed from your
local network.
Link to this document - Allows adding hyperlink to another page or shape in the current document,
Go to Link - allows to go to the hyperlink without closing the dialog.
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You can assign hyperlinks to  the shape's text as well. This can only be done in the text editing mode.
To open this dialog from the context menu make a right mouse click on the selected text.

The link will be assigned to the selected words/characters.
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Presentation

Use Presentation panel to operate  ConceptDraw DIAGRAM dynamic presentations. Access the panel
from the Panels list at the View tab.
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Slide Show

Operate slideshow using these command buttons.
You can play a slide presentation of the current document Slides will be created from document's pages.
Hover the mouse over the bottom of the screen to access the presentation control panel.
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Options

Set the consecutive order of Slide Show.
Change document size to fit monitor resolution.
When the Presentation panel is active, the slide frame is highlighted in green. Thus, you can see how
the size of a real page fits the dimensions of the monitor that you select for the presentation. You can
change the size of the presentation slide so that it matches the dimensions of the presentation monitor.
ConceptDraw DIAGRAM supports multi-monitor usage. The only limit is that ConceptDraw DIAGRAM
can run only one presentation at a time. So, you can run a presentation in one monitor and have the
same or a different document open for editing on the second monitor. By default every presentation is
displayed on the primary monitor.To run a presentation on the secondary monitor select the monitor from
 Output Device drop-down list.
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Info

You can call the dialog from the View  tab by clicking the Info button or using the  Panels list.
Shows the information about selected object. (If  several objects are selected , the dialog shows the
information about object, selected first).

· Meta Data
Contains meta data related to an object: name, description including name of the parent library and
keywords that will help to search this object. 

· Developer Info
Contains:  ID - the unique identification number of the object within current document;
Sub ID - the unique identification number of the object within current group;
Layer - number of Layer where object is located.
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Custom Properties

This dialog is used to view and edit user-defined data of shapes. You can call the dialog from the Shape

menu by clicking the Custom Properties button or using the  Panels list at the View tab,  or from
the context menu in the document window. Prior to calling the dialog, select the shape which properties
you're going to view or edit. If there are several selected shapes, the properties will be shown for the
shape with primary selection (the one that displays green handles). 

If the shape has no custom properties, you'll be offered to  Define Custom Properties.

     

The upper part of the dialog displays the list of custom properties of the shape. The list contains the
names of the properties (the Label field in the Define Custom Properties dialog) and the values of the
properties (the Value field in the Define Custom Properties dialog). Depending on the value format, the
value field may be either an input field, or a drop down list. Prompt - displays the tip for the property (if it
was defined in the Prompt field of the Define Custom Properties dialog). Add Custom Properties... - calls
the Define Custom Properties dialog where you can edit the existing properties, or add new ones. 
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Advanced

Access the panel from the Panels list at the View tab. Edit object behavior, protection, and double-

click properties.

· Lock
Define parameters of an object that should be locked from changes

· Behavior on Double Click
Define Double-Click actions:

Perform no action - No actions on Double-Click;

Edit  text - Edit a text of an Object;

Power Edit Table - Edit Shape Parameter Table;

Edit group - Open a new window for grouped objects editing;

Go to Hyperlink  - Open hyperlink;

Action - Choose one actions, assigned to object. The assigned action will be performed continuously

with Double-Click.

· Miscellaneous 
2D Shape - The selected object is assigned as two-dimensional. You can resize it by changing its

height and width;

Connector - The selected object is assigned as one-dimensional. You can resize it by changin its height

only. It can be connected to another with connecting points (the same as connector);

Scale with Group - All objects scale similarly and simultaneously around group center;

Reposition only - Group resizing will move grouped objects without resizing;

Inherit Group Settings - Apply the entire group settings while  resizing individual objects from this group;
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Save Original Scale -  if this option is on, the shape will keep its size when inserted into a document

with some other scale. Otherwise, the size of the shape will be changed according to the scale settings

of that document.

Shape Handles - Show/Hide handles of selected objects

Control Handles - Show/Hide control handles of selected objects

Alignment box - Show/Hide alignment frame around selected objects

Hide in Presentation - Allows not to display selected objects in Presentation mode 

Group text - Enable/Disable object text editing in group;

Select group only - Enable/Disable selecting individual objects within a group.

Select Group first - The first click on the object that is included in a group will select the entire group,

the next click will select this object within the group.

Select Child First  - The first click on the object that is included in a group will select this object within

the group, the next click will select the entire group.



Floating Panels

ConceptDraw DIAGRAM  User Interface Reference © 2020 CS Odessa corp.

106

Colors  

Colors

Colors panel is a horizontal bar at the bottom of a document window. Access the panel from the Panels
list at the View tab. Colors panel provides quick access to manage the color of  fill ,line and text of the
selected object.  Switching between controls is done by clicking on the left edge of the panel.
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Context Menu

ConceptDraw DIAGRAM enables  access the most frequently used operations with objects via the
context menu. There are different types of context menu related to different pieces selected.  The figure
below displays all the types of context menus. However, actually, you can see only one menu  -
depending on the selected item. 

1 - Pages Context Menu 
2-  Library and Library Object Context menu 
3 - Object Context Menu
4 - Text Context Menu
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Page Context Menu

Context menu of the Pages panel provides fast and easy way to manage document pages. You can add
pages, remove them. or perform other page operations.

Add Page - add a blank page at the end of the document
Insert Page - add a blank page below the selected page
Duplicate page - duplicate the selected page
Rename Page  - rename the selected page
Choose Background - assign a background for the selected page from a list of
all document's pages. By default, the new page has no background

Set as Background for  - set the selected page as a background to other
pages. By default, the new page is not a background page

Remove Page - remove page from the document
View as - change the page preview appearance 

Adjust to Drawing Content - resize page to fit a content
Properties - open the Page Properties dialog
Create new document - Copy the selected page to a new document
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Library Context Menu

ConceptDraw DIAGRAM enables manage libraries and objects using the context menus.

A library context menu appears when you right-click a library preview in the Solutions panel.

New  - create a new empty library.
Open - Open an existing library using the Open dialog.
Save - Save changes in the existing library using the Save As dialog.
Save as  - Save a new library using  the Save As dialog. 
Send via E-mail - Send a copy of the file in an e-mail as an attachment.
Note: The default location of the saved libraries : C:\Users\UserName\Documents\My ConceptDraw.
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Library Context Menu 

Show file location - Show where the library is stored on the disk
Properties -  Open the Library Properties dialog

The context menu of the library object that is called when you right-click an object in the Library pane
contains the most of commands from the library menu (see above), plus the library object management
commands.

New Library - Create a new empty library.
Close Library - Close the currently opened library.
Close All Libraries - Close all libraries.
Save  Library- Save changes in the existing library using the Save As dialog.
Save Library as  - Save a new library using  the Save As dialog. 
Send Library via E-mail - Send a copy of the file in an e-mail as an attachment.
Note: The default location of the saved libraries : C:\Users\UserName\Documents\My ConceptDraw.
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Library Context Menu 

Show Library file location - Show where the library is stored on the disk
Library Properties -  Open the Library Properties dialog
Add Section - You can create library subdivisions - sections. Using sections is the best way to organize
a library with a large number of objects. The drop-down arrow allows you to show/hide the content of a
section. 

Cut, Copy, Paste, Delete - you can perform the common operations with library items
Replace - Replace the selected library object with the object selected on a drawing page. 
Change icon - You can replace the object icon with any graphic image using the Open dialog.
Move to Section - You can move objects between library's sections.
Properties - open the Library Item Properties dialog.
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Library Context Menu 

You can change the Library items appearance:
View as Icons  

View as Icons and Text 

View as Icons and Text Right 
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Object Context Menu 

Object Context Menu

ConceptDraw DIAGRAM allows you to access the most frequently used operations with objects via the
context menu.

Cut, Copy, Paste, Delete - you can perform the common operations with an object.
Change Shape - You can change the selected object to another.
Shape Properties - Open the Shape Properties Dialog.
Text Format - Open the Text Properties dialog 
Fit to Text - Make the sizes of object appropriate to the text size.
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Object Context Menu 

Object - Provide quick access to some options commonly managed from the Arrange panel. Also
enables select the object's text for further editing.

Hypernote - Activate the Hypernote panel.
Lock - Provides quick access to Lock options commonly managed from the "Lock" section of the
Advanced panel. 
Custom Properties - Activate the Custom Properties panel.
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Text Context Menu  

Text Context Menu

ConceptDraw DIAGRAM allows you to access the most frequently used operations with text via the
context menu. There different ways to select  a text. You can select a desired piece of text using the
Text Selection Tool, or you can select the entire text using the Edit Text command from the Object
context menu.

Cut, Copy, Paste, Select - you can perform the common operations with a selected text the same as
with object.
Bold, italic, Underline - Provide quick access to some options commonly managed in the Home tab.
Text Format - Open the Text Properties dialog.
Hyperlink  -  Open the Set Hyperlink dialog.
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Status Bar

The Status Bar  is available at the bottom of the document window and displays  information about the
current window's state.

1. The Scroll Hand tool is used to scroll the document.
2. The Zoom Box tool is used to zoom in and zoom out, keeping  screen focused on the selected
objects.
3. Fit to Page tool  is used to  zoom a drawing to fit the current document window.
4. Zoom Control tool is used to set the zoom level visually by scrolling the pointer left, or right.
5. Zoom Percentage tool is used to set a zoom level in percents.
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Keyboard Shortcuts and Mouse Actions

DOCUMENT AND WINDOWS

Keyboard / Mouse Operation

Ctrl + N Create a new document

Ctrl + Alt + N Create a new document from a template

Ctrl+Shift+open Library Open an earlier saved template preview

Ctrl + O Open a document/template/workspace file.

Ctrl + S Save the active document

Ctrl + Shift + S Save the document under a new filename

F5 Start Presentation

Ctrl + P Print the active document

Ctrl + Alt + P Print Preview

Ctrl + Alt + R Show Page breaks

Ctrl + F Find and Replace

Ctrl + Shift + G Set Grid properties for the active document

Ctrl + Shift + U Set Snap&Glue options f

Ctrl + W Close the active window

Ctrl + Tab Activate the next window

F3 Open Shape Parameter Table

Alt + F4, Ctrl + Q Quit ConceptDraw DIAGRAM

Ctrl + F1 Open  About dialog
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VIEW

Keyboard / Mouse Operation

Ctrl + “+” Zoom In

Ctrl + “-” Zoom Out

Ctrl + Shift + Z Activate the Zoom Box mode

Click/ Click + Alt in Zoom Box Zoom In/ Zoom Out

Ctrl + Shift + 0 Set zoom to Whole Page

Click in Print Preview Change zoom level (in cycle)

PgUp Scroll one window space up

PgDn Scroll one window space down

Ctrl + Home Go to the top-left corner of the page

Ctrl + End Go to the bottom-left corner of the page

Ctrl + PgUp Go to the previous page

Ctrl + PgDn Go to the next page

SELECTING SHAPES

Select with Shift Allows to select several shapes

Ctrl + A Select all the shapes on page

Ctrl +T Activate Text Selection Tool

Tab/ Shift + Tab Select the next/ previous shape

Shift Select objects without quitting the mode
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HYPERLINKS

Keyboard / Mouse Operation

Ctrl + Shift + E Create / Edit hyperlink

Ctrl + Shift + H Open hyperlink

EDITING

Ctrl + Z Undo the last operation

Ctrl + Y Redo what was reversed by Undo

Ctrl + X, Shift + Del Cut the selection to the Clipboard

Ctrl + C, Ctrl + Ins Copy the selection to the Clipboard

Ctrl + V, Shift + Ins Paste

Ctrl + Alt + V Paste Special

Ctrl + Shift + V Paste in Place

Del Delete the selected shape(s)

Ctrl + D, Ctrl for dragging Duplicate the selected shape(s)

Insert Vertex with Ctrl Cut the line in this place

Ctrl in drawing Add the new segment to the selected figure

LIBRARIES

Ctrl + Shift + N Create a new library

Ctrl + Shift + O Open a library

Ctrl + Shift + I Replace the library object with page object
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SHAPES

Keyboard / Mouse Operation

Ctrl + Alt + B Send to Back

Ctrl + Alt + F Bring to Front

Ctrl + Shift + B Send Backwards

Ctrl + Shift + F Bring Forward

Ctrl + J Flip Vertical

Ctrl + H Flip Horizontal

Ctrl + L Rotate Left (90 degrees)

Ctrl + R Rotate Right (90 degrees)

Ctrl + Left/Right Rotate by 1 degree

Ctrl + Shift + Left/Right Arrow Rotate by 0.1 degree

Rotate with Ctrl Rotate around common rotation center

Resize with Shift Toggle between resizing types

Arrows Move the selection one pixel at a keystroke

Shift + Arrows Move the selection a few pixels at a keystroke

Ctrl + G Group the selected shapes into one

Keyboard / Mouse Operation

Ctrl + E Edit Group

Ctrl + U Ungroup
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DRAWING MODES

Keyboard / Mouse Operation

Ctrl + 1 Activate Select tool

Ctrl + 2 Activate Text tool

Ctrl + 3 Activate Line tool

Ctrl + 5 Activate Direct Connector tool

Ctrl + Alt + 5 Activate Arc Connector tool

Ctrl + Shift + 5 Activate Bezier Connector tool

Ctrl + 6 Activate Spline tool

Ctrl + 7 Activate Rectangle tool

Ctrl + 8 Activate Ellipse tool

Ctrl + 9 Activate Smart Connector tool

Ctrl + Alt + 9 Activate Curve Connector tool

Ctrl + Shift + 9 Activate Rounded Connector tool

Ctrl +Shift + R Activate Rapid Draw mode

Ctrl + 0 Activate Eyedropper tool

F2 Activate the Text Editing mode

Hold down Space Activate Scroll Hand tool

Shift in drawing Constrained drawing (circle, square, etc.)

Alt for drawing or moving objects Invert (activate or disable) the Snap mode
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TEXT FORMATTING

Keyboard / Mouse Operation

Ctrl + Shift + T Format Text

Ctrl + B Bold for selected text

Ctrl + I Italic for selected text

Ctrl + U Underline selected text

Ctrl + L Align on the left for selected text

Ctrl + E Align in the center for selected text

Ctrl + R Align on the right for selected text

Ctrl + “.” Increase font

Ctrl + “,” Decrease font

Esc Finish editing

APPLICATION

F1 Call Help System

Ctrl + “;” Preferences (Application Settings)
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